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NEW QUESTION 1
You have a table in a Microsoft SQL Server database that has more than 5 columns. A sample of the data and some of the columns are shown in the following
table.

The table contains more than two million rows. You have 100 clients and 10 products.
You need to load the data to Excel. The solution must minimize the amount of memory used by the model. What should you do?

A. Move the database to a Microsoft Azure SQL databas
B. Load the table to the data model.
C. Load the data to the data model as three tables named Clients, Orders, and Product
D. Ensure that each table has only the relevant column
E. Remove duplicate rows from Clients and Products.
F. Load the data to one worksheet.
G. Load the data to three worksheets named Clients, Orders, and Product
H. Ensure that each worksheet has only the relevant column
I. Remove duplicate rows from Clients and Products.

Answer: B

NEW QUESTION 2
You use a workbook query to import a table named Customers that contains a column named CustomerName. CustomerName has names in the format of
Lastname, Firstname.
You need the CustomerName column to contain names in the format of Firstname Lastname. A space must separate Firstname and Lastname.
Which two commands should you use? To answer, drag the appropriate fields to the correct areas. Each field may be used once, more than once, or not at all.
You may need to drag the split bar between panes or scroll to view content.
NOTE: Each correct selection is worth one point.

A. Mastered
B. Not Mastered

Answer: A

Explanation: 
 Split Column By Delimiter
 Merge Columns

https://support.office.com/en-us/article/split-a-column-of-text-power-query-5282d425-6dd 0-46ca-95bf-8e0da9539662
https://support.office.com/en-us/article/merge-columns-power-query-80ec9e1e-1eb6-4048-b500-d5d42d9f0

NEW QUESTION 3
Note: This question is part of a series of questions that present the same scenario. Each question in the series contains a unique solution that might meet the
stated goals. Some question sets might have more than one correct solution, while others might not have a correct solution.
After you answer a question in this section, you will NOT be able to return to it. As a result, these questions will not appear in the review screen.
You have a query named Queryl that retrieves the user information from two Excel files. One of the Excel files does not contain location information. A sample of
the data retrieved by the query is shown in the following table.

You need to ensure that values in UserName are unique. The solution must ensure that the locations are retained. A sample of desired output is shown in the
following table.

Solution: You select the UserName and Location columns, and then you click Keep Duplicates. Does this meet the goal?
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A. Yes
B. No

Answer: B

NEW QUESTION 4
Note: This question is part of a series of questions that use the same scenario. For your convenience, the scenario is repeated in each question. Each question
presents a different goal and answer choices, but the text of the scenario is the same in each question in this series.
Start of repeated scenario
You have six workbook queries that each extracts a table from a Microsoft Azure SQL database. The table are loaded to the data model, but the data is not loaded
to any worksheets. The data model is shown in the Data Model exhibit. (Click the Exhibit button.)
Your company has 100 product subcategories and more than 10,000 products.

End of repeated scenario.
You have a PivotChart that uses Manufacturer as the axis and the sum of SalesAmount as the values. You need to ensure that only the top 10 manufactures
appear in the chart.
What should you do?

A. Change the format of the SalesAmount field.
B. Create a calculated column.
C. Configure the Value Filters.
D. Summarize the SaleAmount field by Max.

Answer: C

Explanation: 
https://www.extendoffice.com/documents/excel/1963-excel-pivot-table-filter-top-10.html 

NEW QUESTION 5
Note: This question is part of a series of questions that present the same scenario. Each question in the series contains a unique solution that might meet the
stated goals. Some question sets might have more than one correct solution, while others might not have a correct solution.
After you answer a question in this section, you will NOT be able to return to it As a result, these questions
will not appear in the review screen.
Your company has sales offices in several cities.
You create a table that the represents the amount of sales in each city by month as shown in the exhibit.
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You need to ensure that alt values lower than 250 display a red icon. The solution must ensure that all values greater than 500 display a green icon.
Solution: You create a new conditional formatting rule that uses the Format only cells that contain rule type. Does this meet the goal?

A. Yes
B. No

Answer: A

NEW QUESTION 6
You create an Excel workbook named SalesResults.xlsx. You create a workbook query that connects to a Microsoft SQL Server database and loads data to the
data model. You create a PivotTable and a PivotChart.
You plan to share SalesResults.xlsx to several users outside of your organization.
You need to ensure that the users can see the PivotTable and the PivotChart when they open the file. The data in the model must be removed.
What should you do?

A. Run the Document Inspector.
B. Save the workbook as an Excel Binary Workbook (.xlsb).
C. From Query Editor, open the Data Source Settings and delete the credentials.
D. Modify the source of the query.

Answer: C

NEW QUESTION 7
You have multiple workbook queries that load data from tables in Microsoft Azure SQL Database to a Power Pivot data model.
You discover that new rows were added to the tables in Azure SQL Database. You need to ensure that the workbook has the new data.
Why should you do?

A. Select a cell in the worksheet and pressF5.
B. From the data tab, click Refresh All.
C. Close and open the workbook.
D. From the Power Pivot tab, click Update All.

Answer: B

Explanation: 
Refresh data from a Microsoft Query, the Data Connection Wizard, or web query

 Click any cell in the range or table that contains the link to the external data.
 On the Data tab, in the Connections group, click Refresh All.

 To update only the selected data, click Refresh.
You can also right-click a cell in the range or table, and then click Refresh.

 To update all the data connections in the workbook, click Refresh All.
Note: If you have more than one workbook open, you'll need to repeat the operation in each workbook. https://support.office.com/en-us/article/refresh-an-external-
data-connection-in-excel-2016-for-windows-152417

NEW QUESTION 8
You create the PivotChart shown in the exhibit. (Click the Exhibit button.) Exhibit:

In which area is Product and in which area is SalesAmount? To answer, drag the appropriate fields to the correct areas. Each field may be used once, more than
once, or not at all. You may need to drag the split bar between panes or scroll to view content.
NOTE: Each correct selection is worth one point.
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A. Mastered
B. Not Mastered

Answer: A

Explanation: 
Box 1: Product: Axis
Box 2: SalesAmount: Values

NEW QUESTION 9
Note: This question is part of a series of questions that use the same scenario. For your convenience, the scenario is repeated in each question. Each question
presents a different goal and answer choices, but the text of the scenario is the same in each question in this series.
Start of repeated scenario.
You are creating reports for a car repair company. You have four datasets in Excel spreadsheets. Four workbook queries load the datasets to a data model. A
sample of the data is shown in the Data Sample exhibit. (Click the Exhibit button.)
Data Sample exhibit:

The data model is shown in the Data Model exhibit. (Click the Exhibit button.)

The tables in the model contain the following data:
 DailyRepairs has a log of hours and revenue for each day, workshop, and repair type. Every day, a log entry is created for each workshop, even if no hours or

revenue are recorded for that day. Total Hours and Total Revenue column.
 Workshops have a list of all the workshops and the current and previous workshop managers. The format of the Workshop Manager column is always

Firstname Lastname. A value of 1 in the IsLatest column indicates that the workshop manager listed in the record is the current workshop manager.
 RepairTypes has a list of all the repair types
Dates has a list of dates from 2015 to 2018

End of repeated scenario.
You create the column chart shown in the Pivot Chart exhibit. (Click the Exhibit button.)
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You need to ensure that the month axis is displayed chronologically. What should you do?

A. In the model, configure the Sort By Column setting for [Month] as [MonthID].
B. In the model, configure the Sort By Column setting for (Month) as [Date].
C. In PivotTable Fields, add [MonthID] to the Legend area.
D. In PivotTable Fields, add [Date] to the Legend area.

Answer: B

NEW QUESTION 10
You have a KPI named Goal that calculates the sales from the previous year and multiplies the sales by 1.1. You need to modify Goal to multiply the sales from
the previous year by 1.15.
What should you do?

A. From Power Pivot, modify the measure.
B. From the properties of the KPI, modify the KPI base field.
C. From Power Pivot, create a new calculated column, and then modify the KPI.
D. From the properties of the KPI, modify the absolute value.

Answer: A

NEW QUESTION 10
You have an Excel workbook that contains a table named Sales. You add Sales to the Power Pivot model.
You need to set a column named TransactionID as the row identifier for the Sales table. What should you do?

A. From Power Pivot, modify the Table Behavior setting.
B. From Query Editor, add an index column.
C. From Query Editor, modify the Data Type.
D. From Power Pivot, modify the Default Field Set.

Answer: A

Explanation: 
https://msdn.microsoft.com/en-us/library/hh560542(v=sql.110).aspx

 In the Data View of your PowerPivot Window, click the PowerPivot Window: Advanced Tab.
 Click the table tab at the bottom of the window to select the table for which you are configuring

properties.
 In Reporting Properties, click Table Behavior.
 Set the Row Identifier, and then proceed to specify other properties in this dialog.

Opening the Table Behavior dialog box https://ksdconsultancy.blog/2015/10/08/set-table-behaviour-in-powerpivot/

NEW QUESTION 14
You have a workbook query that loads data from C:\Data\Users.xlsx. You move Users.xlsx to a shared folder on the network.
You need to ensure that you can refresh the data from Users.xlsx. What should you do?

A. From the Linked Table tab in Power Pivot, modify the Update Mode.
B. From Query Editor, modify the Source step.
C. From the Insert tab in Excel, click My Add-ins, and then manage the add-ins.
D. From the Data tab in Excel click Connections, and then modify the properties of the connection.

Answer: D

NEW QUESTION 19
Note: This question is part of a series of questions that present the same scenario. Each question in the series contains a unique solution that might meet the
stated goals. Some question sets might have more than one correct solution, while others might not have a correct solution.
After you answer a question in this section, you will NOT be able to return to it. As a result, these questions will not appear in the review screen.
You have the following data.
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You need to retrieve a list of the unique ProductName entries.
Solution: Open the Advanced Filter dialog box, select Filter the list, in-place, and then select Unique records only.
Does this meet the goal?

A. Yes
B. No

Answer: A

NEW QUESTION 20
Note: This question is part of a series of questions that use the same scenario, For your convenience is repeated in each question. Each question presents a
different goal and answer choices, but the text of the scenario is the same in each question in this series.
Start of repeated scenario
You have six workbook queries that each extracts a table from a Microsoft Azure SQL database. The tables are loaded to the data model, but the data is not
loaded to any worksheets. The data model is shown in the Data Model exhibit.
Your company has 100 product subcategories and more than 10,000 products. End of repeated scenario.
You need to create a measure named [Sales Monthly RT] that calculates a running total of [Sales] for each date within a month as shown in the following exhibit.

How should you complete the DAX formula? To answer, select the appropriate options in the answer area. NOTE: Each correct selection is worth one point.

A. Mastered
B. Not Mastered

Answer: A

Explanation: 
SUM [Sales], DATESMTD
The following sample formula creates a measure that calculates the 'Month To Date Total' for the Internet sales.
To see how this works, create a PivotTable and add the fields, CalendarYear, MonthNumberOfYear and
DayNumberOfMonth, to the Row Labels
area of the PivotTable. Then add a measure, namedMonth To Date
Total, using the formula defined in the code section, to the Values
area of the PivotTable.
=CALCULATE(SUM(InternetSales_USD[SalesAmount_USD]), DATESMTD(DateTime[DateKey])) https://msdn.microsoft.com/en-us/query-bi/dax/datesmtd-
function-dax

NEW QUESTION 25
Note: This question is part of a series of questions that present the same scenario. Each question in the series contains a unique solution that might meet the
stated goals. Some question sets might have more than one correct solution, while others might not have a correct solution.
After you answer a question in this section, you will NOT be able to return to it. As a result, these questions will not appear in the review screen.
You have the following data.
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You need to retrieve a list of the unique ProductName entries.
Solution: Create a PivotTable that uses the ProductName field in the Rows area. Does this meet the goal?

A. Yes
B. No

Answer: B

NEW QUESTION 30
Your network contains a folder that has data files m various formats.
You need to identify how many files of each extension type are in the folder by using Query Editor. What should you do?

A. Create a query that uses a file source, and then use the Count Values command on the Transform tab.
B. Create a query that uses a folder source, and then use the Group By command on the Home tab.
C. Create a query that uses a file source, and then use the Group By command on the Home tab.
D. Create a query that uses a folder source, and then use the Count Values command on the Transform tab.

Answer: B

NEW QUESTION 32
You open an Excel worksheet as shown in the following exhibit.

You need to export the data into a dataset in the Microsoft Power BI service. What should you do first?

A. Save the tile as an Excel template.
B. Select the data, and then insert a table.
C. Select the data, and Then insert a PivotTable.
D. Install Power BI Publisher for Excel.

Answer: D

NEW QUESTION 35
Note: This question is part of a series of questions that use the same scenario. For your convenience, the scenario is repeated in each question. Each question
presents a different goal and answer choices, but the text of the scenario is the same in each question in this series.
Start of repeated scenario
You have six workbook queries that each extracts a table from a Microsoft Azure SQL database. The tables are loaded to the data model, but the data is not
loaded to any worksheet. The data model is shown in the Data Model exhibit. (Click the Exhibit button.)
Your company has 100 product subcategories and more than 10,000 products.
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End of repeated scenario.
You need to create a measure named [Sales Monthly RT] that calculates a running total of [Sales] for each date within a month as shown in the following exhibit.

A. Mastered
B. Not Mastered

Answer: A

Explanation: 
SUM([Sales],DATESMTD(DimDate[Date])) CALCULATE(SUM([Sales],DATESMTD(DimDate[Date])))

NEW QUESTION 38
Note: This question is part of a series of questions that present the same scenario. Each question in the series contains a unique solution that might meet the
stated goals. Some question sets might have more than one correct solution, while others might not have a correct solution.
After you answer a question in this section, you will NOT be able to return to it. As a result, these questions will not appear in the review screen.
You have a Power Pivot model that contains the following tables.?
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There is a relationship between Products and ProductCategory.
You need to create a hierarchy in Products that contains ProductCategoryName and ProductName. Solution: You create a measure that uses the
USERELATIONSHIP DAX function.
Does this meet the goal?

A. Yes
B. No

Answer: B

NEW QUESTION 39
You have an Excel workbook that displays two PivotCharts. One chart displays sales by month. The other chart displays sales by year.
You add a slicer for month.
You discover that when you select a month in the slicer, the data in the sales by year PivotChart changes. You need to prevent the slicer from affecting the sales
by year PivotChart.
What should you do?

A. Remove all the fields from the Filters area of the sales by month PivotChart.
B. Modify the Value Field Settings for the values of the sales by year PivotChart,
C. Modify the Report Connections of the slicer.
D. Remove all the fields from the Filters area of the sales by year PivotChart.

Answer: C

NEW QUESTION 41
Note: This question is part of a series of questions that present the same scenario. Each question in the series contains a unique solution that might meet the
stated goals. Some question sets might have more than one correct solution, while others might not have a correct solution.
After you answer a question in this section, you will NOT be able to return to it. As a result, these questions will not appear in the review screen.
You have two Microsoft SQL Server database servers named Production1 and Test1. Production1 contains the same tables as Test1. but only a subset of the
data.
You add Test1 as a data source, and you select 10 tables. You configure several transformations. You need to connect the model to the tables in Production1. The
solution must maintain the existing
transformations.
Solution: You delete the existing queries, and then you add new data sources. Does this meet the goal?

A. yes
B. No

Answer: B

NEW QUESTION 46
You have an Excel workbook that has the following two workbook queries:
A query named consultants that retrieves a table named Consultants_Contact from a Microsoft SQL Server database
A query named employees that retrieves a table named Employee_Contact from a Microsoft Azure SQL database
Both tables have the same columns.
You need to combine all the data from Consultants and Employees into one table. Which command should you use?

A. Transpose
B. Append Queries
C. Merge Queries
D. Combine Binaries

Answer: B

Explanation: 
Append is similar to UNION ALL in T-SQL.
http://radacad.com/append-vs-merge-in-power-bi-and-power-query

NEW QUESTION 49
You need to create a combo chart to display the count of orders by month and profit by month as shown in the exhibit. (Click the Exhibit tab.)
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How should you configure the combo chart? To answer, select the appropriate options in the answer area. NOTE: Each correct selection is worth one point.

A. Mastered
B. Not Mastered

Answer: A

Explanation: 
Order Count:Stacked columnNo Profit:LineYes
http://www.excel-easy.com/examples/combination-chart.html
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NEW QUESTION 52
Note: This question is part of a series of questions that use the same scenario. For your convenience, the scenario is repeated in each question. Each question
presents a different goal and answer choices, but the text of the scenario is the same in each question in this series.
Start of repeated scenario.
You are creating reports for a car repair company. You have four datasets in Excel spreadsheets. Four workbook queries load the datasets to a data model. A
sample of the data is shown in the Data Sample exhibit. (Click the Exhibit button.)
Data Sample exhibit:

The data model is shown in the Data Model exhibit. (Click the Exhibit button.)

The tables in the model contain the following data:
 DailyRepairs has a log of hours and revenue for each day, workshop, and repair type. Every day, a log entry is created for each workshop, even if no hours or

revenue are recorded for that day. Total Hours and Total Revenue column.
 Workshops have a list of all the workshops and the current and previous workshop managers. The format of the Workshop Manager column is always

Firstname Lastname. A value of 1 in the IsLatest column indicates that the workshop manager listed in the record is the current workshop manager.
 RepairTypes has a list of all the repair types
 Dates has a list of dates from 2015 to 2018

End of repeated scenario.
You need to create a PivotChart that displays the month, the hours of the month, and the hours of the previous month, as shown in the following exhibit.

Which DAX formula should you use for the Total Hours Last Month measure? To answer, drag the appropriate fields to the correct targets. Each value may be
used once, more than once, or not at all. You may need to drag the split bar between panes or scroll to view content.
NOTE: Each correct selection is worth one point.

A. Mastered
B. Not Mastered

Answer: A

Explanation: 
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IF (ISBLANK[(Total Hours]),BLANK(), CALCULATE([total Hours], DATEADD(tblDates(Date),
-1,MONTH)))

NEW QUESTION 53
You have a workbook query that loads data from a table named Products. Products contains a column named IntemalPrice that has a Data Type of Decimal.
From Query Editor you create a custom column named ResellerPrice that uses a formula to multiply InternalPrice by 1.2, and then you remove the IntemalPrice
column.
What will occur when you load the data to a worksheet?

A. All the columns except InternalPrice will load to the worksheet The values in ResellerPrice will be correct.
B. An error message will appear and all the data will fail to load.
C. An error message will appear and all the columns except InternalPnce and ResellerPrice will load to the worksheet.
D. All the columns except InternalPrice will load to the workshee
E. The values in ResellerPrice will be null.

Answer: D

NEW QUESTION 56
You have a table that contains sales data.
You need to create a Pivot Table that will display the sales by country as shown in the following exhibit.

What should you use to display the icons?

A. a measure
B. conditional formatting
C. data validation
D. a KPI

Answer: B

NEW QUESTION 60
You have the data model shown in the exhibit.

You need to create a hierarchy from DimProductSubcategory[ProduaSubcategoryName]andDimProduct[ProductName].
What should you do before you create the hierarchy?

A. Create a relationship between the table
B. To DimProductSubcategory, add a calculated column named ProductName that uses the
LOOKUPVALUE(DimProduct[ProductName],DimProduct[ProductKey],[ProductKey]) DAX formula.
C. To DimProduct, add a calculated column named ProductSubcategoryName that uses the LOOKUPVALUE(DimProductSubcategory
[ProductSubcategoryName],DimProductSubcategory[ProductCategoryKey],[ProductSubcategoryKey]) DAX formula.
D. Create a relationship between the table
E. To DimProduct, add a calculated column named ProductSubcategoryName that uses the RELATEDTABLE
(DimProductSubcategory[ProductSubcategoryName]) DAX formula.
F. To DimProduct, add a calculated column named ProductSubcategoryName that uses the VALUES(DimProductSubcategory[ProductSubcategoryName]) DAX
formula.

Answer: B

NEW QUESTION 65
Note: This question is part of a series of questions that use the same scenario, For your convenience is repeated in each question. Each question presents a
different goal and answer choices, but the text of the scenario is the same in each question in this series.
Start of repeated scenario
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You are creating reports for a car repair company. You have four datasets in Excel spreadsheets. Four workbook queries load the datasets to a data model. A
sample of the data is shown in the Data Sample exhibit.

The data model is shown in the Data Model exhibit.

The tables in the model contain the following data:
DailyRepairs has a log of hours and revenue for each day, workshop, and repair type. Every day, a log entry is created for each workshop, even if no hours or
revenue are recorded for that day. Total Hours and Total Revenue are two measures defined in DailyRepairs. Total Hours sums the Hours column, and Total
Revenue sums the Revenue column.
Workshops has a list of all the workshops and the current and previous workshop managers. The format of the Workshop Manager column is always Firstname
Lastname, A value of 1 in the IsLatest column indicates that the workshop manager listed in the record is the current workshop manager.
Repair types has a list of all the repair types. Dates has a list of all the repair types.
Dates has a list of dates from 2015to 2018. End of repeated scenario.
You need to create a PivotChart that displays the month, the hours of the month, and the hours of the previous month, as shown in the following exhibit.

Which DAX formula should you use for the Total Hours Last Month measure? To answer, drag the appropriate values to the correct targets. Each value may be
used once, more than once, or not at all. You may need to drag the split bar between panes or scroll to view content.
NOTE: Each correct selection is worth one point.

A. Mastered
B. Not Mastered

Answer: A

Explanation: 
IF (ISBLANK([Total Hours]), BLANK(), CALCUATE [Total Hours], DATESADD (tblDates[Date]),
-1,MONTH)))

NEW QUESTION 69
Note: This question is part of a series of questions that use the same scenario. For your convenience, the scenario is repeated in each question. Each question
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presents a different goal and answer chokes, but the text of the scenario is the same in each question in this series.
Start of repeated scenario
You are creating reports for a car repair company. You have four datasets in Excel spreadsheets. Four workbook queries load the datasets to a data model. A
sample of the data is shown in the Data Sample exhibit.
Data Sample exhibit:

The data model is shown in the Data Model exhibit. (Click the Exhibit button.)

The tables in the model contain the following data:
 DailyRepairs has a log of hours and revenue for each day, workshop, and repair type. Every day, a log entry is created for each workshop, even if no hours or

revenue are recorded for that day. Total Hours and Total Revenue column.
 Workshops have a list of all the workshops and the current and previous workshop managers. The format of the Workshop Manager column is always

Firstname Lastname. A value of 1 in the IsLatest column indicates that the workshop manager listed in the record is the current workshop manager.
 RepairTypes has a list of all the repair types
 Dates has a list of dates from 2015 to 2018

End of repeated scenario.
When you attempt to create a relationship between DailyRepairs and Workshops, Power Pivot generates the following error message: “The relationship cannot be
created because each column contains duplicate values. Select at least one column that contains only unique values”.
You need to ensure that you can create a valid relationship between the tables. What should you do?

A. In the Power Pivot model, change the data type for Workshop[ID] to General
B. In the workbook query for Workshops, add an index column
C. In the Power Pivot model, change the Table Behavior setting for Workshops
D. In the workbook query for Workshops, filter [IsLatest] to equal 1

Answer: C

Explanation: 
References: https://msdn.microsoft.com/en-us/library/hh560544(v=sql.110).aspx

NEW QUESTION 74
Note: This question is part of a series of questions that use the same scenario. For your convenience, the scenario is repeated in each question. Each question
presents a different goal and answer choices, but the text of the scenario is the same in each question in this series.
Start of repeated scenario.
You are creating reports for a car repair company. You have four datasets in Excel spreadsheets. Four workbook queries load the datasets to a data model. A
sample of the data is shown in the Data Sample exhibit. (Click the Exhibit button.)
Data Sample exhibit:
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The data model is shown in the Data Model exhibit. (Click the Exhibit button.)

The tables in the model contain the following data:
 DailyRepairs has a log of hours and revenue for each day, workshop, and repair type. Every day, a log entry is created for each workshop, even if no hours or

revenue are recorded for that day. Total Hours and Total Revenue column.
 Workshops have a list of all the workshops and the current and previous workshop managers. The format of the Workshop Manager column is always

Firstname Lastname. A value of 1 in the IsLatest column indicates that the workshop manager listed in the record is the current workshop manager.
 RepairTypes has a list of all the repair types
 Dates has a list of dates from 2015 to 2018

End of repeated scenario.
To the Dates table, you need to add a calculated column named Months Ago. Months Ago must display the number of calendar months before the current month.
For example, if the current date is July 10, 2017, the Value of Months Ago will be 0 for all the dates in July 2017, 1 for all the dates in June 2017, and 2 for all the
dates in May 2017.
How should you complete the DAX formula? To answer, select the appropriate options in the answer area. NOTE: Each correct selection is worth one point.

A. Mastered
B. Not Mastered

Answer: A

Explanation: 
Box 1: MONTH
Box 2: TODAY
References:
https://msdn.microsoft.com/en-us/library/ee634914.aspx https://msdn.microsoft.com/en-us/library/ee634567.aspx https://msdn.microsoft.com/en-
us/library/ee634554.aspx

NEW QUESTION 78
You have a workbook query that loads data from a table in a Microsoft Azure SQL database. The table has a column named LineTotal. The following is a sample
of the data in LineTotal:
• 40
• 1
• 999
• 7658
• 883432
You need to ensure that when you load the data to the model, LineTotal is set as currency. What should you do from Query Editor?
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A. Configure the Data Type
B. Round the column.
C. Split the column by characters.
D. Split the column by delimiter.

Answer: A

NEW QUESTION 81
You have the following tables in a data model.

You create a PivotTable to display SaleAmount by Month. A sample of the results are shown in the following table.

You need to ensure that the data appears in chronological order. What should you do?

A. In the data model, modify the Sort By Column setting for Date[Month Year]
B. From PivotTable Fields, add Date[Year] to the Rows area
C. In the data model, modify the Sort by Column setting for Sales[Date]
D. From PivotTable Fields, modify the Field Settings for Date[Month Year]

Answer: D

NEW QUESTION 84
You have the following table named SalesOrder Detail in a model.

You need to calculate the sum of SalesTotal for all the rows that have a quantity greater than 1.

A. Mastered
B. Not Mastered

Answer: A

Explanation: 
CALCULATE(SUMX(‘SalesOrdersDetail’[SalesTotal]),‘SalesOrderDetail’[Quantity] > 1)
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NEW QUESTION 87
You add two tables named Date and Invoices to a data model, Invoices contains a column named InvoiceDate that has a Data Type of Date, Date contains a
column named DateID that has a Data Type of which Number. DateID is in the format of YYYYMMDD.
You need to create a relationship between Date and Invoices. What should you do first?

A. Change the Data Type of InvoiceDate and DateID to Text.
B. Create a measure in Invoices that uses the Format DAX Function.
C. Change the Data Type of DateID to Date.
D. Create a calculated column in Invoices that uses the Format DAX function.

Answer: C

Explanation: 
https://support.office.com/en-us/article/data-types-in-data-models-e2388f62-6122-4e2b-bcad-053e3da9ba90?ui= 

NEW QUESTION 89
You have a workbook query that loads the following table

You pivot the table on the Key column by using Value as the values column, and you receive the results shown in the following table.

You need to ensure that the data appears as shown in the following table.

What should you do?

A. Change the aggregate value function of the pivot.
B. Select the ID column, and then click Unpivot Columns
C. Change the Data Type of the Value column.
D. Delete the Picoted Column ste
E. Select the Key column, and the click UnpivotColumns.

Answer: B

Explanation: 
References:
https://support.office.com/en-us/article/unpivot-columns-power-query-0f7bad4b-9ea1-49c1-9d95-f588221c7098

NEW QUESTION 93
You have a PivotChart template named Template1. You add a PivotChart to a worksheet.
You need to apply the template to the PivotChart. What should you do?

A. On the Design tab, click Change Chart Type.
B. On the Format tab, click Format Selection.
C. Right-click the chart and then click PivotChart Options.
D. Right-click the chart and then click Format Chart Area.

Answer: A

Explanation: 
 Click the chart
 On the Charts tab, under Change Chart Type, click Other, and then under Templates, click the chart template that you created.

https://stackoverflow.com/questions/17386777/how-to-apply-a-saved-chart-template-to-an-existing-chart

NEW QUESTION 95
You have a workbook query that retrieves data from a table named Users. Users contains a column named PhoneNumber. The following is a sample of the data in
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PhoneNumber.
514 555 0169
1 (11) 500 555-0122
128 555-0148
819 555-0186
1-996-555-0192
+1 138-555-0156
556-555-0192
You need to create a custom column that contains the data in PhoneNumber in the format of 999-999-9999. The following is a sample of the desired data.
514-555-0160
500-555-0122
128-555-0148
819-555-0186
996-555-0192
138-555-0156
556-555-0192
How should you complete the Query Editor formula? To answer, drag the appropriate values to the correct targets. Each value may be used once, more than once,
or not at all. You may need to drag the split bar between panes or scroll to view content.
NOTE: Each correct selection is worth one point.

A. Mastered
B. Not Mastered

Answer: A

Explanation: 
Text.Replace(Text.End([Phone],12)," ","-")

NEW QUESTION 100
You have a Power Pivot data model that contains a table named DimProduct DimProduct has seven columns named ProductKey, ProductLabel, ProductName,
ProductDescription, ProductSubCategoryKey, Manufacturer, and Brand.
Only the members of the product team use all the data in the DimProduct table.
You need to simplify the model for other users by hiding all the columns except ProductName. What should you do?

A. Create a perspective that has only the ProductName field from DimProduct selected.
B. Select all the columns in DimProduct except ProductName, right-click the columns, and then click Hide from Client Tools.
C. Edit the Default Field Set for DimProduct and add ProductName to the Default Field.
D. Edit the Table Behavior settings for DimProduct and add ProductName to the Default Label.

Answer: B
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Explanation: 
https://support.office.com/en-us/article/hide-columns-and-tables-in-power-pivot-ddf5b1f2-2ed2-4bdb-8f78-6f94

NEW QUESTION 105
Note: This question is part of a series of questions that use the same scenario, For your convenience is repeated in each question. Each question presents a
different goal and answer choices, but the text of the scenario is the same in each question in this series.
Start of repeated scenario
You are creating reports for a car repair company. You have four datasets in Excel spreadsheets. Four workbook queries load the datasets to a data model. A
sample of the data is shown in the Data Sample exhibit.

The data model is shown in the Data Model exhibit.

The tables in the model contain the following data:
DailyRepairs has a log of hours and revenue for each day, workshop, and repair type. Every day, a log entry is created for each workshop, even if no hours or
revenue are recorded for that day. Total Hours and Total Revenue are two measures defined in DailyRepairs. Total Hours sums the Hours column, and Total
Revenue sums the Revenue column.
Workshops has a list of all the workshops and the current and previous workshop managers. The format of the Workshop Manager column is always Firstname
Lastname. A value of 1 in the IsLatest column indicates that the workshop manager listed in the record is the current workshop manager.
RepairTypes has a list of alt the repair types. Dates has a list of dates from 2015 to 2018. End of repeated scenario.
You create a measure named Average Revenue Per Hour that calculates the average revenue per hour.
You need to populate a cell in a worksheet to display the Average Revenue Per Hour where Repair Type is Engine.
Which Excel formula should you use?

A. Option A
B. Option B
C. Option C
D. Option D

Answer: D

NEW QUESTION 106
Note: This question is part of a series of questions that present the same scenario. Each question in the series contains a unique solution that might meet the
stated goals. Some question sets might have more than one correct solution, while others might not have a correct solution.
After you answer a question in this section, you will NOT be able to return to it. As a result, these questions will not appear in the review screen.
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You have a query named Query1 that retrieves the user information from two Excel files. One of the Excel files does not contain location information. A sample of
the data retrieved by the query is shown in the following table.

You need to ensure that values in UserName are unique. The solution must ensure that the locations are retained. A sample of desired output is shown in the
following table.

Solution: You use the Group By function to group the rows by UserName and you specify output columns for UserID and Location by using the Max operation.
Does this meet the goal?

A. Yes
B. No

Answer: B

NEW QUESTION 107
You have a query that retrieves customers and their locations. You have a sample of the data as shown in the following table.

Additional customers and locations are added frequently.
You need to transform the data as shown in the following table.

What should you do?

A. Select the Locations columns and then select Split Column by Delimite
B. Use a comma as the delimiter and split into rows.
C. Select the Locations columns and then select Split Column by Delimite
D. Use a comma as the delimiter and split into columns.
E. Select the Customer columns, and then click Unpivot Columns.
F. Select the Customer columns, and then click Unpivot Other Columns.

Answer: A

NEW QUESTION 108
You have a model that contains data relating to corporate profits. The model contains a measure named Profit.
You need to create a PivotTable to display the Profit measure in three different formats by using the Show Value As feature. The PivotTabte must produce the
results shown in the following table.
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How should you configure the Show Value As feature for % Profit of Annual Total and % Profit of Grand Total? To answer, select the appropriate options in the
answer area.
NOTE: Each correct selection is worth one point.

A. Mastered
B. Not Mastered

Answer: A

Explanation: 
% Profit of Annual Total: % of Parent Total
% Profit of Grand Total: % of Column Total
https://support.office.com/en-us/article/show-different-calculations-in-pivottable-value-fields-014d2777-ba

NEW QUESTION 110
You have a workbook query that uses an Excel data source. The data source contains the following table.

You need the data to appear as shown in the following table.
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How should you transform the data from Query Editor? To answer, select the appropriate options in the answer area.
NOTE: Each correct selection is worth one point.

A. Mastered
B. Not Mastered

Answer: A

Explanation: 
Box 1: User and UserID Box 2: Unpivot Columns
References:
https://support.office.com/en-us/article/unpivot-columns-power-query-0f7bad4b-9ea1-49c1-9d95-f588221c7098

NEW QUESTION 113
......
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